
 

1 
 

Picardy commands 
Menus 
All commands are available from the Edit pane. Commands available from the Preview pane and the New/Edit Item dialogs are 
indicated. 
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File New Index Ctrl+N ✓   

New From Template …  ✓   

Open… Ctrl+O ✓   

Save Ctrl+S ✓   

Save As… Ctrl+ShiŌ+S ✓   

Export… Ctrl+R ✓   

Import…  ✓   

Merge…  ✓   

Backups ▶  
            Go To Backups 
            Delete Backups for This Index 
            Delete All Backups 

 
Ctrl+ShiŌ+O 

 
✓ 
✓ 
✓ 

  

Print Edit pane  ✓   

Close file Ctrl+W ✓   

Exit  ✓   

Recent Files ▶  ✓   

Edit Find… Ctrl+F ✓   

Cut Ctrl+X  ✓  

Copy Ctrl+C  ✓  

Paste Ctrl+V  ✓  

Smart Paste Ctrl+ShiŌ+V  ✓  
Paste FormaƩed (Word & web only) Ctrl+Alt+V    
Undo Ctrl+Z    
Redo Ctrl+Y    
Bold Ctrl+B  ✓  

Italic Ctrl+I  ✓  

Small Caps Ctrl+M  ✓  

Ignore in Sort Ctrl+G  ✓  

Use in Sort and Hide Ctrl+H  ✓  
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Item New item… Ctrl+K    
Edit Item… Edit pane: Ctrl+E 

Preview pane: Ctrl+ShiŌ+E 
   

Select Item Ctrl+ShiŌ+A    
Delete Item Ctrl+ShiŌ+D    
Toggle Ignore Item Ctrl+Q    
Flip Headings Ctrl+1  ✓  

Duplicate Item Ctrl+2    
See to Double-post Ctrl+3    
Delete Ignored/Blank Items Ctrl+4    
Collapse Ctrl+5  ✓  

Collapse All Like This Ctrl+6    
Duplicate Pages Ctrl+7    
Join Headings Ctrl+8  ✓  

Duplicate and Flip Ctrl+9    
Capitalize ▶ Main headings 
                       References 

 ✓   

Uncapitalize ▶ Main headings 
                            References 

 ✓   

Main Headings Format ▶ Bold 
                                                Italic 
                                                Plain 

 ✓   

View Preview Ctrl+P ✓   

Preview By Page Number Ctrl+ShiŌ+P ✓   

Highlight Items Created Today Ctrl+ShiŌ+Q ✓   

Highlight Items Modified Today Ctrl+ShiŌ+R ✓   

Scratchpad…  ✓   

Sort Edit Pane  ✓   

Revert Edit Pane  ✓   

Tools Validate Index Ctrl+L    
Check Item Ctrl+ShiŌ+L    
Error Report  ✓   

Check Spelling F2    
Next Mark F3    
Previous Mark F4    
Check UndifferenƟated F8 ✓   

StaƟsƟcs  ✓   

Add Highlight ▶ Choose Color… F7    
Remove Highlight ShiŌ+F7    
Remove All Highlights     
Find Highlights ▶     
Show/Hide Highlights     
Remove Marks  ✓   

Insert/Delete Pages…  ✓   

Character Map…  ✓   
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ConfiguraƟon 
 

Seƫngs…  ✓   

Styles…  ✓   

AbbreviaƟons…  ✓   
RealphabeƟzaƟons…  ✓   
FuncƟon Words…  ✓   
Edit User DicƟonary…  ✓   
Save As Template …  ✓   
Apply Template …  ✓   

Groups New Group …  ✓   
Delete Group …  ✓   
Add Item to Group     
Remove Item from Group     
Edit Group Ctrl+T ✓   
Revert to Index F12 ✓   
Group on SelecƟon     
Group on Marks  ✓   
Group on Highlights ▶  ✓   
Group on Heading  ✓   
Show/Hide Group ▶  ✓   

Clipboard Invert Name Ctrl+F1  ✓  
Invert Name and IniƟalize Ctrl+F2    
Invert Name and IniƟalize (no dots) Ctrl+F3    
Split at Commas Ctrl+F4    
Split Names at Commas and Invert Ctrl+F5  ✓  
Pluralize Ctrl+F6  ✓  
Paste Right-to leŌ name Ctrl+F7  ✓  
Paste Right-to-leŌ text Ctrl+F8  ✓  
Double Quotes Ctrl+"  ✓  
Single Quotes Ctrl+'  ✓  
Italicize Ctrl+ShiŌ+I  ✓  
Embolden Ctrl+ShiŌ+B  ✓  

Help Help File F1 ✓   

Commands  ✓   
About  ✓   
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Context menus 
To access the context menus, right click in the appropriate pane. 

Menu Menu Item Keystroke 
Preview pane View in Edit pane Ctrl+Right arrow 

Edit Ctrl+ShiŌ+E 
Open in Bbrowser  
Select all Ctrl+A 

Edit pane Cut  
Copy  
Paste  
Undo  
Redo  
View in Preview pane Ctrl + LeŌ arrow 
Add to DicƟonary Ctrl+D 
Insert AbbreviaƟon  
Select All Ctrl+A 
Print Edit pane  
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Commands 
To access the context menus, right click in the appropriate pane. 

Command Menu Shortcut BuƩon 
AbbreviaƟons 
   Define 
   Insert 

 
ConfiguraƟon 
Edit pane context menu 

  

About Picardy Help   
Acronyms (AbbreviaƟons) ConfiguraƟon   
Add 
   Highlight 
   Item to group 
   Term to dicƟonary 

 
Tools 
Groups 
Edit pane context menu 

 
F7 
 
Ctrl+D 

 

AlphabeƟcal display 
   Edit pane (Sort) 
   Preview pane (Preview) 

 
View 
View 

 
 
Ctrl+P 

 

AlphabeƟzaƟon 
   Edit pane 
   Hide text 
   Ignore text 
   Overriding (RealphabeƟzaƟon) 
   Seƫng 

 
View 
Edit 
Edit 
ConfiguraƟon 
ConfiguraƟon → Seƫngs 

 
 
Ctrl+H, ^…^ 
Ctrl+G, {…} 

 

As-entered order, Revert to View   
Backups 
   Delete all 
   Delete for this index 
   Go to 
   Set Ɵme and folder 

 
File 
File 
File 
ConfiguraƟons → Seƫngs → Misc 

 
Ctrl+ShiŌ+O 

 

Blank lines, Delete Item Ctrl+4  
Bold text 
   Main headings 
   Pasted text 

Edit 
Item 
Clipboard 

Ctrl+B, *…* 
 
Ctrl+ShiŌ+B 

 

Capitalize 
   Main headings & references 
   Small caps 

 
Item 
Edit 

 
 
Ctrl+M, %…% 

 

Character map Tools   
Check 
   Index (Validate Index) 
   Item 
   Spelling. See Spell check 
   UndifferenƟated page numbers 

 
Tools 
Tools 
 
Tools 

 
Ctrl+L 
Ctrl+ShiŌ+L 
 
F8 

 

Close file File Ctrl+W  
Collapse 
   Item 
   All subheadings 

 
Item 
Item 

 
Ctrl+5 
Ctrl+6 

 

Commands list Help   
ConjuncƟons, Ignore ConfiguraƟon → FuncƟon words   
Copy text Edit 

Edit pane context menu 
Ctrl+C  

Cross-references 
   Capitalize & Uncapitalize 
   Format 
   See to double-post 

 
Item 
ConfiguraƟon → Seƫngs 
Item 

 
 
 
Ctrl+3 

 

Cut text Edit 
Edit pane context menu 

Ctrl+X  
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Command Menu Shortcut BuƩon 
Delete 
   Backups 
   Group 
   Ignored/Blank items 
   Pages 
   Selected item 

 
File 
Groups 
Item 
Tools 
Item 

 
 
 
Ctrl+4 
 
Ctrl+ShiŌ+D 

 

DicƟonary 
   Add term to 
   Edit 

 
Edit pane context menu 
ConfiguraƟon 

 
Ctrl+D 

 

Double-post (See to double-post) Item Ctrl+3  
Duplicate 
   Item 
   and Flip headings 
   Page numbers 

 
Item 
Item 
Item 

 
Ctrl+2 
Ctrl+9 
Ctrl+7 

 

Edit item(s) 
   From Edit pane 
   From Preview pane 
   Group 

 
Item 
Preview pane context menu 
Groups 

 
Ctrl+E 
Ctrl+ShiŌ+E 
Ctrl+T 

 
 
 

Edit pane 
   As-entered order 
   Print 
   Sorted order 
   Style 
   View item in (from Preview pane) 

 
View 
File;  Edit pane context menu 
View 
ConfiguraƟon → Styles 
Preview pane context menu 

 
 
 
 
 
Ctrl+Right arrow 

 

Error tracking 
   Export report 
   Validate index 
   Validate item 

 
Tools 
Tools 
Tools 

 
 
Ctrl+L 
Ctrl+ShiŌ+L 

 

Exit File   
Export index 
   Report 
   Seƫngs 

File 
Tools 
ConfiguraƟon → Seƫngs 

Ctrl+R  

Filing order. See AlphabeƟzaƟon    
Find text Edit Ctrl+F  
Flip headings 
   and Duplicate item 

Item 
Item 

Ctrl+1 
Ctrl+9 

 

Format text 
   Bold 
   Italics 
   Main headings 
   Small caps 

 
Edit 
Edit 
Item 
Edit 

 
Ctrl+B 
Ctrl+I 
 
Ctrl+M 

 
 
 

FuncƟon words, Ignore ConfiguraƟon   
Groups 
   Add item 
   Delete group 
   Edit group 
   Group on highlights 
   Group on marks 
   Group on selecƟon 
   Hide group 
   New group 
   Remove item 
   Revert to index 
   Show group 

 
Groups 
Groups 
Groups 
Groups 
Groups 
Groups 
Groups 
Groups 
Groups 
Groups 
Groups 

 
 
 
Ctrl+T 
 
 
 
 
 
 
F12 
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Command Menu Shortcut BuƩon 
Headings 
   Capitalize & Uncapitalize 
   Collapse subheading 
   Collapse all subheadings 
   Flip 
   Format 
   Group on 
   Join 

 
Item 
Item 
Item 
Item 
Item 
Groups 
Item 

 
 
Ctrl+5 
Ctrl+6 
Ctrl+1 
 
 
Ctrl+8 

 

Help Help F1  
Hide 
   Hide groups 
   Hide highlights 
   Hide text in Sort 

 
Groups 
Tools 
Edit 

 
 
 
Ctrl+H, ^…^ 

 

Highlight/s 
   Add 
   Find 
   Group on 
   Items created today 
   Items modified today 
   Remove 
   Remove all 
   Show/Hide 

 
Tools 
Tools 
Groups 
View 
View 
Tools 
Tools 
Tools 

 
F7 
 
 
Ctrl+ShiŌ+Q 
Ctrl+ShiŌ+R 
ShiŌ+F7 

 
 

 
 
 
 
 

 

Ignore 
   Delete ignored items 
   FuncƟon words 
   Item 
   In Sort 

 
Item 
ConfiguraƟon 
Item 
Edit 

 
Ctrl+4 
 
Ctrl+Q 
Ctrl+G, {…} 

 

Import index File   
Indexes 
   Backups 
   Close 
   Export 
   Import 
   Merge 
   New 
   New from template 
   Open 
   Recent 
   Save 
   Save as 

 
File 
File 
File 
File 
File 
File 
File 
File 
File 
File 
File 

 
Ctrl+ShiŌ+O 
Ctrl+W 
Ctrl+R 
 
 
Ctrl+N 
 
Ctrl+O 
 
Ctrl+S 
Ctrl+ShiŌ+S 

 
 

Insert pages Tools   
Invert name and paste 
   and iniƟalize 
   and iniƟalize (no dots) 

Clipboard 
Clipboard 
Clipboard 

Ctrl+F1 
Ctrl+F2 
Ctrl+F3 

 

Italics 
   Main headings 
   Pasted text  

Edit 
Item 
Clipboard 

Ctrl+I, _…_ 
 
Ctrl+ShiŌ+I 

 
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Command Menu Shortcut BuƩon 
Items 
   Add to group 
   Collapse 
   Collapse all 
   Delete 
   Delete ignored/blank items 
   Duplicate 
   Edit 
   Ignore 
   Format main headings 
   New 
   Remove from group 
   Select 

 
Groups 
Item 
Item 
Item 
Item 
Item 
Item 
Item 
Item 
Item 
Groups 
Item 

 
 
Ctrl+5 
Ctrl+6 
Ctrl+ShiŌ+D 
Ctrl+4 
Ctrl+2 
Ctrl+E 
Ctrl+Q 
 
Ctrl+K 
 
Ctrl+ShiŌ+A 

 
 
 
 
 
 

 
 

 

Keyboard shortcuts list Help → Commands   
Labels see Groups; Highlights    
Lists, Split at commas Clipboard Ctrl+F4  
Locators, see Page numbers    
Join headings and subheadings Item Ctrl+8  
Main headings. See Headings    
Marked items 
   Go to next 
   Go to previous 
   Group on 
   Remove marks 

 
Tools 
Tools 
Groups 
Tools 

 
F3 
F4 

 
 
 
 

Merge indexes File   
Names, Paste 
   Invert 
   Invert and iniƟalize 
   Invert and iniƟalize (no dots) 
   Right-to-leŌ 
   Split at commas and invert 

 
Clipboard 
Clipboard 
Clipboard 
Clipboard 
Clipboard 

 
Ctrl+F1 
Ctrl+F2 
Ctrl+F3 
Ctrl+F8 
Ctrl+F5 

 

New group Groups   
New index 
New from Template 

File 
File 

Ctrl+N  

New item Item Ctrl+K  
Next mark Tools F3  
Open index File Ctrl+O  
Output See Export index    
Page numbers 
   Check undifferenƟated 
   Duplicate 
   Format 
   Insert/delete 
   Preview by 
   Separators 

 
Tools 
Item 
ConfiguraƟon → Seƫngs 
Tools 
View 
ConfiguraƟon → Seƫngs → Export 

 
Ctrl+F8 
Ctrl+F7 
 
 
Ctrl+ShiŌ+P 

 

Page number order, Preview pane View Ctrl+ShiŌ+P  
Paste name from MS Word & browser 
   Invert 
   Invert and iniƟalize 
   Invert and iniƟalize (no dots) 
   Right-to-leŌ 
   Split at commas and invert 

Clipboard 
Clipboard 
Clipboard 
Clipboard 
Clipboard 
Clipboard 

Ctrl+F8 
Ctrl+F1 
Ctrl+F2 
Ctrl+F3 
Ctrl+F7 
Ctrl+F5 
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Command Menu Shortcut BuƩon 
Paste text 
   From Picardy item 
   From  PDF, MS Word or web browser 
      Double quotes 
      Embolden 
      FormaƩed (Word & browser only) 
      Italicize 
      Pluralize 
      Right-to-leŌ 
      Single quotes 
      Smart 

 
Edit; Edit pane context menu 
 
Clipboard 
Clipboard 
Edit 
Clipboard 
Clipboard 
Clipboard 
Clipboard 
Clipboard 

 
Ctrl+V 
 
Ctrl+" 
Ctrl+ShiŌ+B 
Ctrl+Alt+V 
Ctrl+ShiŌ+I 
Ctrl+F6 
Ctrl+F8 
Ctrl+' 
Ctrl+ShiŌ+V 

 
 

Pluralize pasted text Clipboard Ctrl+F6  
PreposiƟons, Ignore ConfiguraƟon → FuncƟon words   
Preview pane 
   Go to; Alpha order; Refresh 
   Open in browser 
   Page number order 
   Style 
   View item in (from Edit pane) 

 
View 
Preview pane context menu 
View 
ConfiguraƟon → Styles 
Right click in Edit pane 

 
Ctrl+P 
 
Ctrl+ShiŌ+P 
 
Ctrl+LeŌ arrow 

 
 

 

Previous mark Tools F4  
Print Edit pane File   
Quote marks in pasted text 
   Double 
   Single 

 
Clipboard 
Cllpboard 

 
Ctrl+” 
Ctrl+’ 

 

RealphabeƟzaƟons ConfiguraƟon   
Recent indexes File   
Redo (Reverse Undo) Edit 

Edit pane context menu 
Ctrl+Y  

References 
   Capitalize & Uncapitalize 
   Format 
   See to double-post 

 
Item 
ConfiguraƟon → Seƫngs 
Item 

 
 
 
Ctrl+3 

 

Remove item from group 
Remove marks 

Groups 
Tools 

  
 

Revert to index from group Groups F12  
Right-to-leŌ text 
   Paste name 
   Paste text 

 
Clipboard 
Clipboard 

 
Ctrl+F7 
Ctrl+F8 

 

Save 
   Save as 
   Template 

File 
File 
ConfiguraƟon 

Ctrl+S 
Ctrl+ShiŌ+S 

 
 

Scratchpad View   
See to double-post Item Ctrl+3  
Select item 
Select all items 
SelecƟon, Group on 

 
Right click 
Groups 

Ctrl+ShiŌ+A 
Ctrl+A 

 

Separators aŌer headings ConfiguraƟon → Seƫngs → Export   
Seƫngs ConfiguraƟon   
Shortcuts list Help → Commands   
Show 
   Groups 
   Highlights 

 
Groups 
Tools 

  

Smart paste Clipboard Ctrl+ShiŌ+V  
Small caps Edit Ctrl+M, %…%  
Sort order. See AlphabeƟzaƟon    
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Command Menu Shortcut BuƩon 
Spell check 
   Check spelling 
   Edit dicƟonary 
   Language 

 
Tools 
ConfiguraƟon 
ConfiguraƟon → Seƫngs 

 
F2 

 
 

Split list and paste 
   Names at commas and invert 
   Text at commas 

 
Clipboard 
Clipboard 

 
Ctrl+F5 
Ctrl+F4 

 

StaƟsƟcs Tools   
Styles, Seƫng ConfiguraƟon   
Subheadings 
   Collapse all 
   Collapse item 
   Join with heading 

 
Item 
Item 
Item 

 
Ctrl+6 
Ctrl+5 
Ctrl+8 

 

Templates 
   Apply 
   New index from 
   Save as 

 
ConfiguraƟon 
File 
ConfiguraƟon 

  

Text 
   Bold 
   Hide in sort 
   Ignore in sort 
   Italics 
  Small caps 

 
Edit 
Edit 
Edit 
Edit 
Edit 

 
Ctrl+B, *…* 
Ctrl+H, ^…^ 
Ctrl+G, {…} 
Ctrl+I, _..._ 
Ctrl+M, %   % 

 
 
 
 
 

 

Toolbar list Help → Commands   
Uncapitalize Main headings & references Item   
UndifferenƟated page numbers, Check Tools F8  
Undo Edit 

Edit pane context menu 
Ctrl+Z  

Validate 
   Index 
   Item 

 
Tools 
Tools 

 
Ctrl+L 
Ctrl+ShiŌ+L 
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Keyboard shortcuts 
FuncƟon Keys 

F1 Help F7 Add Highlight 
F2 Check Spelling F8 Check UndifferenƟated 
F3 Next Mark F12 Revert to Index (Groups) 
F4 Previous Mark ShiŌ+F7 Remove Highlight 

 

Control+ 
A Select All 1 Flip Heading 
B Bold 2 Duplicate Item 
C Copy 3 See to Double-post 
E Edit Item … 4 Delete Ignored/Blank Items 
F Find … 5 Collapse 
G Ignore in Sort 6 Collapse All Like This 
H Use in Sort and Hide 7 Duplicate Pages 
I Italic 8 Join Headings 
K New Item … 9 Duplicate and Flip 
L Validate Index   
M Small Caps F1 Clipboard: Invert Name 
N New Index F2 Clipboard: Invert Name and IniƟalize 
O Open … F3 Clipboard: Invert Name and IniƟalize (no dots) 
P Preview F4 Clipboard: Split at Commas 
Q Toggle Ignore Item F5 Clipboard: Split Names at Commas and Invert 
R Export … F6 Clipboard: Pluralize 
S Save F7 Clipboard: Paste Right-to-leŌ Name 
T Edit Group F8 Clipboard: Paste Right-to-leŌ Text 
V Paste   
W Close File " Clipboard: Double Quotes 
X Cut ' Clipboard: Single Quotes` 
Y Redo   
Z Undo   

 
Control+ShiŌ+ 

A Select Item P Preview by Page Number 
B Clipboard: Embolden Q Highlight Items Created Today 
D Delete Item R Highlight Items Modified Today 
I Clipboard: Italicize S Save As … 
L Check Item V Smart Paste 
O Go To Backups   

 

Control+Alt+ 
V Paste FormaƩed 

 

 



 

 
 

Toolbar 
 

                          
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KEYBOARD SHORTCUTS 

 
 

Edit 
New/Edit 
Item dialog 

  

 Find… Ctrl+F 
● Cut Ctrl+X 
● Copy Ctrl+C 
● Paste Ctrl+V 
● Smart Paste Ctrl+ShiŌ+V 
 Paste FormaƩed Ctrl+Alt+V 
 Undo Ctrl+Z 
 Redo Ctrl+Y 

● Bold Ctrl+B 
● Italic Ctrl+I 
● Small Caps Ctrl+M 
● Ignore in Sort Ctrl+G 
● Use in Sort and Hide Ctrl+H 

Item 
 New item… Ctrl+K 
 Edit Item… Ctrl+E 
 Select Item Ctrl+ShiŌ+A 
 Delete Item Ctrl+ShiŌ+D 
 Toggle Ignore Item Ctrl+Q 

● Flip Headings Ctrl+1 
 Duplicate Item Ctrl+2 
 See to Double-post Ctrl+3 
 Delete Ignored/Blank Items Ctrl+4 

● Collapse Ctrl+5 
 Collapse All Like This Ctrl+6 
 Duplicate Pages Ctrl+7 

● Join Headings Ctrl+8 
 Duplicate and Flip Ctrl+9 

Groups 
 Edit Group Ctrl+T 
 Revert to Index F12 

Clipboard 
● Invert Name Ctrl+F1 
● Invert Name and IniƟalize Ctrl+F2 
● Invert Name and IniƟalize (no dots) Ctrl+F3 
 Split at Commas Ctrl+F4 
 Split Names at Commas and Invert Ctrl+F5 

● Pluralize Ctrl+F6 
● Paste Right-to leŌ name Ctrl+F7 
● Paste Right-to-leŌ text Ctrl+F8 
● Double Quotes Ctrl+" 
● Single Quotes Ctrl+' 
● Italicize Ctrl+ShiŌ+I 
● Embolden Ctrl+ShiŌ+B 

 


